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Chapter 1: Welcome to Serena
Orchestrated Ops

Serena Orchestrated Ops contains three solutions that can be used independently or
together to create a world-class IT solution.

The individual solutions in Serena Orchestrated Ops include:

• Serena Request Center

• Serena Demand Manager

• Serena Service Manager

This guide covers all three components. Refer to the particular sections in this guide for
information on the components that you purchased. Refer to Purpose of this Guide for
details on what this guide covers.

Serena Request Center
Serena Request Center provides a one-stop interface for corporate users to discover and
request IT services, submit requests, and review knowledge base articles. It comes with a
rich, interactive, and intuitive Web portal. The portal contains an enterprise service
catalog allowing services to be composed, organized, and published into convenient
categories for anytime, anywhere access.

The portal comes pre-populated with IT Services that use the request fulfillment
workflows in the Service Desk Process App, such as New Hire and Install OS. The services
also make use of the Starter Pack Forms, which are customized external forms for
submitting requests.

Serena Demand Manager
Serena Demand Manager helps organize and plan incoming demand from across the
organization. It provides an intuitive interface for planners and managers to create views
of demand items, and then add them to plans so they can be ranked, scored, and voted
on. You can also create teams and allocate them to plans, then track their overall
capacity.

You can use Serena Demand Manager with the provided Project Proposals process app,
your own process apps, or both.

Serena Service Manager
Serena Service Manager is a process-driven approach to IT service management – one
that allows business and IT to work together, in perfect harmony. Unlike traditional ITSM
solutions that are difficult to use, expensive to maintain, and provide limited visibility
across the service delivery lifecycle, Serena Service Manager draws on the power of a
process management platform at its core to provide the following benefits:

• Lower total cost of ownership (TCO)
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• Complete visibility

• Improved user satisfaction and agent productivity

• Contemporary interface for IT services

Serena Service Manager comes packaged with fully functional, easy-to-use applications
including those for Request, Incident, Problem, Change, and Configuration Management.

Service Manager also provides the IT operations team with visual dashboards and robust
report generation capabilities so they can maintain complete visibility across the end-to-
end service delivery process. This includes the ability to view actionable metrics related to
costs and resource utilization.

Purpose of This Guide
This guide describes how to upgrade Serena Orchestrated Ops.

This guide is meant for administrators who are responsible for upgrading an existing SOO
installation. It includes detailed information on upgrading the file system and the SOO
solution files. For all other information, refer to the following documents that are included
with your installation:

• Serena Orchestrated Ops On-Premise Installation and Configuration Guide or Serena
Orchestrated Ops On-Demand Installation and Configuration Guide for detailed
information about initially installing, configuring, and deploying the solutions.

• Serena Orchestrated Ops Administrator's Guide for detailed information about
administrative duties you perform in SOO.

• Serena Service Manager ITIL Guide for details on Service Manager workflows and
their features.

• Serena Orchestrated Ops readme for a list of new features in this release.

For detailed information on modifying projects, users, workflows, or orchestrations in the
process apps after you have promoted them, refer to the following guides that are
included with your Serena® Business Manager installation:

• SBM Application Administrator Guide for configuring projects, users, and groups.

• SBM Composer Guide for modifying workflows, orchestrations, and other aspects of
process app design.

• SBM Application Repository Guide for deploying and promoting snapshots and
process apps.

• SBM Installation and Configuration Guide for installing and configuring the SBM
platform.

Chapter 1: Welcome to Serena Orchestrated Ops
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Chapter 2: Preparing for the Upgrade

This chapter contains important information to help you prepare for the upgrade.

• Overview [page 7]

• Preupgrade Steps [page 7]

• Important Notes for Upgrades [page 8]

• Creating a Comparison Report in SBM Composer [page 9]

Overview
The Serena Orchestrated Ops upgrade process consists of two phases: the installation
upgrade and the solutions upgrade.

• In the installation upgrade phase, you run the SOO installer and configure your
installation using SBM Configurator. This installs the newest versions of the
framework files and configures your installation to use them.

• In the solutions upgrade phase, you import the new solutions and decide if you will
preserve or overwrite the modifications you have likely made to the process apps.

Note:

The solutions upgrade phase is optional. If you want to preserve your current
workflows and data (forgoing the latest versions of the process apps), simply
run the SOO installer and configure your installation using SBM Configurator as
described in Chapter 3: Upgrading the Installation [page 11].

If you want to upgrade your process apps to the latest versions as well, review
the list of changes in Chapter 4: Upgrading SSM 2.1 Process Apps [page 15] or
Chapter 5: Upgrading SSM 3.0 Process Apps [page 25] (depending on the
version you are upgrading from), and then upgrade the solutions.

Preupgrade Steps
Before you begin the upgrade process:

1. Decide if you will upgrade your current SOO process apps. Use the list of changes
described in Chapter 4: Upgrading SSM 2.1 Process Apps [page 15] or Chapter 5:
Upgrading SSM 3.0 Process Apps [page 25] (depending on your current version) to
help you determine if you will upgrade your process apps.

2. If you are not using at least SBM version 10.1 or 10.1.1.1, follow the instructions in
the SBM 10.1 or 10.1.1.1 readme to upgrade your existing SBM installation. Note
that SSM 2.1 is still accessible to your users after the upgrade to SBM 10.1.

3. After you have successfully upgraded to SBM 10.1 or 10.1.1.1 (or verified that you
are currently using either version), back up your existing SBM database before
installing SOO 3.1.
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4. Review the Important Notes for Upgrades [page 8] section to ensure your database
is prepared for the upgrade and that you are prepared to run the SOO installer on
the proper servers.

5. If you decide to upgrade your process apps, follow the steps described in Creating a
Comparison Report in SBM Composer [page 9] to help you identify changes you
have made to the process apps that you might want to preserve.

6. Back up the installation directory structure for SBM on your SBM Application Engine
machine.

7. Stop the following services on the SBM Application Engine server: Internet
Information Services – IIS, Serena Common JBoss, and the Notification Server and
Mail Client.

Note: You can stop IIS and the Serena Common JBoss Service on the
Manage Services tab of SBM Configurator.

8. Download SOO 3.1 from support.serena.com.

Important Notes for Upgrades
Review the following important notes for all upgrades from previous versions of Serena
Orchestrated Ops.

• For Oracle systems, the Oracle schema user requires a certain set of roles and
privileges to enable "Oracle Text" for use with the Social Widget control that is
enabled by default in the SOO process apps. See S133641 for details.

Important: You must apply these roles and privileges to the Oracle
schema user prior to promoting or deploying the SOO apps.

• For SQL Servers systems, you must ensure that "Full-Text Indexing" is enabled in
the DBMS. Note the following:

▪ In SQL Server 2005, "Full-Text Indexing" is enabled automatically once you
successfully a deploy any process app in which the Social Widget is enabled, as
long as the "Full-Text Search" feature was selected during the SQL Server DBMS
install.

▪ In SQL Server 2008, "Full-Text Indexing" is selected by default for all databases,
as long as the "Full-Text Search" feature was selected during the SQL Server
DBMS install.

Note: The Full-Text Search feature in SQL Server is an optional install
component. Therefore, verify that the feature is installed in SQL Server
first. To verify this, right-click on the database in SQL Server, select
Properties, and then select the Files page. “Use full-text indexing” should
be selected.

• Prior to Serena Service Manager 3.0, the SSM installation was performed on the
server or servers that hosted the SBM Application Engine and the Application
Administrator. As of SBM 10.1, the Application Administrator was renamed to
Application Repository. The SOO 3.1 installation is performed on the server or
servers that host the following SBM SBM components:

Chapter 2: Preparing for the Upgrade
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▪ SBM Application Engine

▪ SBM Application Repository

▪ SBM Common Services

Note: As of version 3.0, the Service Level Agreement (SLA) component is
included with the installation. The SLA component is installed on the SBM
server that hosts SBM Common Services. For distributed environments,
this means you must determine which SBM server hosts the SBM Common
Services component and run the SOO installer on this server to install the
SLA component.

• The SOO installation differs from the 2.x versions in that you must now run SBM
Configurator, set the appropriate SLA load-level setting for your environment, and
then click Apply after the installer is finished. This enables SBM Configurator to
perform important updates to various configuration files on your server (or servers if
your installation is distributed).

• If you do not see any services in the catalog after upgrading to SOO 3.1, perform the
following steps:

1. Copy the Common.zip and SRP.zip from
Serena\Solutions\SSM\Framework\Shell.

2. Paste both .zip files into Serena\SBM\Application Engine\payload.

3. Reset IIS.

4. Launch the User Workspace and then access Serena Request Center.

Creating a Comparison Report in SBM Composer
This section describes how to create a report in SBM Composer that helps you identify the
changes you have made to your process apps. You will use this report to determine which
changes you want to preserve and copy to the new version of each process app.

It is recommended that you compare your current process apps to the original versions
that were installed with SSM 2.1 or SSM 3.0 (depending on your current version). If you
did not make any changes to the process apps or you do not want to preserve your
changes, then simply follow the steps in Chapter 3: Upgrading the Installation [page 11]
to upgrade the framework files to the latest version. If you want to use the latest versions
of the process apps as well, then perform the steps Chapter 3: Upgrading the Installation
[page 11] and then perform the steps in either Chapter 4: Upgrading SSM 2.1 Process
Apps [page 15] or Chapter 5: Upgrading SSM 3.0 Process Apps [page 25] to import and
promote the new apps.

To create a comparison report:

1. In Application Repository, click the Environments tab.

2. Click the environment name to open it.

3. Click the Deploy History tab.

4. Select the process app and click Open.
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5. Select version 1 of the process app and then click Save to File.

6. Select the latest version of the process app that you have deployed and then click
Save to File.

Tip: Take note of this file name and save location. If you determine that
you want to preserve the modifications you have made, you will use this
file in the merge steps later on.

7. Launch SBM Composer and Import version 1 or the process app from the file you
just saved.

8. Select the Compare option from the Composer menu, and open the latest version of
the process app from the file that you saved earlier to launch a side-by-side
comparison.

9. Click the Export button to create a report that shows you the changes you have
made since the initial promotion.

10. Repeat these steps for each of your current process apps.

For details on using the Compare feature, see the "Comparing and Merging Process Apps"
topic in the SBM Composer Guide.

Chapter 2: Preparing for the Upgrade
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Chapter 3: Upgrading the Installation

This section discusses how to upgrade the installation and framework files for all SOO
upgrades.

• About the Installation Upgrade [page 11]

• Upgrading the Installation [page 12]

About the Installation Upgrade
Upgrading the installation involves running the SOO installer and configuring the
installation using SBM Configurator. You must upgrade the installation before you can
import the newest versions of the SOO solutions.

Tip: You can upgrade the installation independently from the solutions upgrade.
This means that you do not need to upgrade the solutions to take advantage of
improvements and additions that have been added to the SOO framework files.

The installation upgrade process updates the SOO framework files, applies the new
configuration, and prepares the system for use by enabling SBM Application Engine to
import the upgraded framework files into the Serena Request Center user interface.

The updated framework files include the following changes:

Serena Demand Manager
Serena Demand Manager enables you to capture and organize incoming demand for
projects, such as new application development, Web site requests, or infrastructure
improvements. Demand items can span multiple business processes, but you can organize
them into plans that provide an overall view into the cost, effort, and benefit of each
project. The Demand Center provides a portal that enables project managers and other
planners to manage incoming demand.

For details on importing the Serena Demand Manager solution and promoting the process
apps, see the Serena Orchestrated Ops On-Premise Installation and Configuration Guide.
For steps on setting up the Demand Center, see the Serena Orchestrated Ops
Administrator's Guide.

Service Level Agreements
The following SLA enhancements are available with Orchestrated Ops 3.1:

• You can now define multiple "start" and "end" states for an Service Level Agreement
(SLA) clause. The time an item spends in all paths is combined to calculate elapsed
time. For example, suppose "New" and "Assigned" are "start" states and "Closed" is
the "end" state. An item spent three days in the "New" to "Closed" path, and then
was re-opened and moved to the "Assigned" state. The re-opened item has been
active for two days. The elapsed time for the item is five days, because the time
since the item was re-opened is added to the previous time.

• You can now copy an SLA to the current project or to a sub-project in its hierarchy.

Upgrade Guide 11



• User Submitter is now included by default in the Calendar list used to define an
SLA clause.

Serena Request Center Improvements
• Serena Request Center now includes the Approval tab where users can view items

requiring their approval.

• The Requests view now allows administrators to choose which report to use for the
tab's results. You are no longer restricted to the Request Center - My Requests
report.

• You can now include links in e-mail notifications that open to items in Request
Center. To do so, select an HTML template for the notification and modify it to
include &shelltab the parameters. For example, to open to items on the Approvals
tab, append the following text to the main server URL (http://your_server/
tmtrack/tmtrack.dll?):

shell=srp&IssuePage&RecordId=$RECORDID()&Template=view&TableId=$TABLEID()&shelltab=approvals

Upgrading the Installation
This section describes the steps you will follow to upgrade your current installation.

To upgrade the installation:

1. Run the SOO installer on the server or servers that host the following SBM
components:

• SBM Application Engine

• SBM Application Repository

• SBM Common Services

Note: If these SBM components are installed separately, you must run the
SOO installer on each server.

The "Welcome to the Install Wizard for Serena Orchestrated Ops" message appears.
Click Next to continue.

2. The installer detects which SBM components are currently installed on the server. A
message appears if any of the required SBM components are not detected on the
server. Click Install to install SOO.

3. Allow the installation to complete. Once the installation is finished, click Configure
to launch SBM Configurator (close and reopen SBM Configurator if it was open
during the SOO install). In the SBM Configurator, set the SLA level for your
environment and then click Apply.

Important: You must launch SBM Configurator and click Apply to finish
the installation and configuration process. When you click Apply, SBM
Configurator updates various configuration files on the server and prepares
the system for use.

Chapter 3: Upgrading the Installation
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4. Access the SBM User Workspace using the following URL and allow the interface to
load:

http://serverName/tmtrack/tmtrack.dll?

Important: Accessing the SBM User Workspace immediately after SBM
Configurator is an important part of the upgrade process. This enables the
SBM Application Engine to import the framework files that comprise the
new simplified user interface (Serena Request Center).

This completes the installation and configuration upgrade. To upgrade the process
apps, continue to the next section that applies to your current version.
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Chapter 4: Upgrading SSM 2.1 Process
Apps

This section discusses how to upgrade your SSM 2.1 process apps to SOO 3.1.

• About Upgrading [page 15]

• Upgrading the Process Apps [page 18]

• Preserving Changes in the Process Apps [page 24]

About Upgrading
This section contains important information about upgrading version 2.1 process apps to
Serena Orchestrated Ops 3.1. Use this section to help you evaluate the changes that have
been made to the process apps and whether or not you want to upgrade to take
advantage of the improvements.

Process App Changes Between 2.1 and 3.0
This sections describes the changes that have been to the process apps since version 2.1.
Review the changes below to help you determine if you want to upgrade your process
apps to the latest versions.

Changes to All Process Apps

The following changes were made in all of the Serena Service Manager process apps.

• Updated look and feel of forms, including new images for forms.

• Dynamic forms have been implemented, which cause the following:

▪ Addition of rules for use with actions, such as setting Priority on a form.

▪ Removal of most state forms. They have been reduced to the following for each
the workflow: Base Active State Form and Base Inactive State Form.

▪ Removal of most JavaScript on the forms.

The dynamic actions can be found on the Actions tab of a state or transition form.

• Replaced aewebservices71 with sbmappservices72.

• Removal of jQuery JavaScript. Now included by choosing the option in SBM
Composer.

Knowledge Management Changes

• Change in workflow for an improved process around saving as draft and editing.

• Addition of rules for checking Expiration Date validity, which are used by dynamic
forms.
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Incident Management & Request Fulfillment Changes

• The process app was renamed to Service Desk.

• Addition of three new workflows under Service Requests.

• Removal of the routing buttons and routing form on the Route transition. As of 3.0,
the routing was done automatically based on the field values.

• Addition of Purchasing role.

• Addition of Auxiliary tables, which are used by the Starter Pack Services.

Change Management Changes

• Addition of forms, tables, and references for the integration with Serena® Release
Manager .

• Create CI Baseline transition which calls the CreateCMSBaseline orchestration to
create a baseline.

Problem Management Changes

• Re-investigate form was renamed to Reinvestigate.

Configuration Management System Changes

• Addition of multiple new transitions, such as Baseline Submit - Existing RFC.

• Addition of JavaScripts to test duplicate titles and auditing.

• Addition of Rules to decide whether to Delete a CI and whether item is already in
pending state.

Process App Changes Between 3.0 and 3.1
This sections describes the changes that have been to the process apps since version 3.0.
Review the changes below to help you determine if you want to upgrade your process
apps to the latest versions.

Service Request Changes

With Orchestrated Ops 3.1, the request fulfillment workflows have been removed from the
Service Desk application. A new Service Requests application has been created. It
contains one request fulfillment workflow.

The Service Requests application is part of the Serena Request Center solution.

The application, previously known as Service Desk, has been renamed to SSM - Incident
Management, and it only contains the Incident Management workflow.

Starter Pack Changes

The Starter Pack has been changed to the point to the new Service Request process app
included with the Serena Request Center. The starter pack now creates subprojects under
the main project associated with this process app. All services that are created point to
this process app. Note that the starter pack includes:

• Service Desk Process App, which includes the Request Fulfillment workflow.

Chapter 4: Upgrading SSM 2.1 Process Apps
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• Starter Pack Services, which are predefined services in Request Center. Each service
has an accompanying project created within the Service Desk Process App.

• Starter Pack Forms, which are tailored submit and state forms for the different
services.

Note: Starter Pack Forms makes use of external forms, which were
introduced in Serena Business Manager 10.1. External forms are located in
one process app but are based on a primary table in another process app.
Starter Pack Forms reference the Service Desk Process App and the
external forms are chosen as the Submit form for the predefined Starter
Pack Services.

About Importing and Promoting
This section provides an overview of the import and promote steps you will follow to
upgrade your current process apps.

Importing the Solutions

To begin upgrading your process apps, you must import the new solution files that are
delivered by the installer. Importing a solution adds all of the snapshots and process apps
for the solution to your SBM Server. The process apps and snapshots are available for
promotion after the import.

To import the solutions:

1. Log in to SBM Application Repository using the following URL:

http://serverName:port/mashupmgr

2. Select the Solutions tab.

3. Click the Import button to begin importing a solution.

Note: A failure message that states "You do not have permission to delete
the obselete snapshot" appears in Application Repository if your
environment contains a process app that is no longer associated with the
solution you are importing and you do not have privileges to delete the
process app. In the Deployment menu, click Privileges, and then grant
the user Delete Process App and Delete Application/Orchestration
privileges to proceed with the import.

4. If you import the Serena Request Center solution for the first time as part of the
upgrade, read the steps described in the "Promoting the Snapshots" chapter in the
Serena Orchestrated Ops On-Premise Installation and Configuration Guide before
you promote the Serena Request Center process app snapshots.

Promoting the Process Apps

After you import a solution, you promote the associated snapshots into your environment.
Promoting the snapshots places the contents of the solution, including all reports,
notifications, process apps, and auxiliary table data, onto your SBM Server.

If you are upgrading from an earlier version, it is likely that you modified the process
apps; therefore, the solutions that are delivered by the installer are not automatically
deployed to your default environment. Before you promote the process apps, you must
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decide if you want to overwrite the current versions of your process apps or if you want to
preserve your modifications. Choose one of the following two options:

• Review the comparison report you generated as part of the pre-upgrade process. If
there are modifications that you made to the process apps that you want to
preserve, use SBM Composer to compare and merge your changes and then deploy
the process apps.

• Promote the new versions without comparing and merging, which will overwrite your
modifications (if any).

Important: Promoting the new snapshots overlays any existing
modifications that you have made to your existing workflows.

Note: During the promotion, select the Merge conflicts option if you have
already promoted an earlier version of the snapshot to the target environment
and you want to preserve changes that you made to the existing application. For
example, if you want to keep new user roles that you added to an application,
select the Merge conflicts check box to preserve them in the target
environment after the promotion. If Merge conflicts is not selected, the
existing entities will be deleted in the target environment.

The following section describes the process app uppgrade process in more detail.

Upgrading the Process Apps
This section describes three different scenarios for upgrading the SSM 2.1 process apps.

As of SOO 3.1, the Service Request workflow has been removed from the Incident
Management process app that was included with SSM 2.1. In its place, a new Service
Requests process app has been created as part of the SRC solution. Given these changes,
there are special upgrade considerations for the Service Desk process app.

Depending on how you have used the Incident Management workflows, choose one of the
following upgrade options:

• Upgrade and delete all existing Incident Management data. For details, see
Upgrading 2.1 Process Apps to 3.1 and Deleting Existing Incident Management Data
[page 18].

• Upgrade and preserve your existing Incident Management data. For details, see
Upgrading 2.1 Process Apps to 3.1 and Preserving Existing Incident Management
Data [page 20].

• Leave the current version of the Incident Management intact and continue using your
existing Service Request, Incident, and Task workflows. For details, see Upgrading
2.x Process Apps to 3.1 Without Upgrading Incident Management [page 23].

Upgrading 2.1 Process Apps to 3.1 and Deleting
Existing Incident Management Data
To upgrade your existing 3.0 process apps and delete your current Incident
Management data:

1. Install and configure SOO 3.1 as described in Chapter 3: Upgrading the Installation
[page 11]. This upgrades the SOO framework files.

Chapter 4: Upgrading SSM 2.1 Process Apps
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2. Launch Application Repository.

3. Grant your user account the following privileges: Delete Process App and Delete
Application/Orchestration.

4. Open the Environments view, click Deployed Process Apps, select the 2.1
Incident Management process app, and click Undeploy Process App.

Important: This operation permanently deletes the Incident Management
primary tables, auxiliary tables, workflows, and projects.

5. Import the SRC 3.1 solution and promote the three process apps. Select Merge
Conflicts during each promotion.

Important: You must promote the SRC apps in a specific order, because
the Starter Pack and Service Requests process apps contain unique
references to one another. This ensures that the proper forms in the
Starter Pack process app are available for use in each of the services.
Promote the SRC apps in the following order:

a. SRC - Starter Pack Forms – IT

b. SRC - Service Requests

c. SRC - Starter Pack Forms – IT (promote again)

d. SRC – Knowledge Management

Important: If you want to preserve any custom modifications that you
made to these process apps, follow the steps in Preserving Changes in the
Process Apps [page 24] to compare and merge the changes and then
deploy the process apps instead of promoting them.

6. Import the SSM 3.1 solution and promote the four process apps. Select Merge
Conflicts during each promotion.

Important: If you want to preserve any custom modifications that you
made to these process apps, follow the steps in Preserving Changes in the
Process Apps [page 24] to compare and merge the changes and then
deploy the process apps instead of promoting them.

7. Launch Serena Request Center, click Customize, and select Service Catalog.
Review each service and catalog in the Request Center to ensure accuracy and
uniqueness.

8. Edit each service that appears throughout the catalog and select the new
corresponding version of each project, if a new version is available. (When you
customize the Service Catalog, a red exclamation mark will appear next to each
service that needs to be updated). For example, edit the Printer Service Request
service, and change the Process App drop-down list selection from Incident
Management to Service Request. Once the Project drop-down selections are
updated, search for the new Printer Service Request project, and then click Save.

Note: The services and projects must have a one-to-one relationship. This
means each service must have a dedicated project; the same project
cannot be selected in multiple services.
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Upgrading 2.1 Process Apps to 3.1 and Preserving
Existing Incident Management Data
To upgrade your existing process apps and preserve your current Incident
Management data:

1. Create a backup of your SBM database. Consult your DBA and restore this backup
into a new database space or schema.

2. Install and configure SOO 3.1 as described in Chapter 3: Upgrading the Installation
[page 11]. This upgrades the SOO framework files.

3. Launch Application Repository.

4. Grant your user account the following privileges: Delete Process App and Delete
Application/Orchestration.

5. Open the Environments view, click Deployed Process Apps, select the 2.1
Incident Management process app, and click Undeploy Process App.

Important: This operation permanently deletes the Incident Management
primary tables, auxiliary tables, workflows, and projects. The following
steps will help you restore these elements and their associated data.

6. Import the SRC 3.1 solution and promote the three process apps. Select Merge
Conflicts during each promotion.

Important: You must promote the SRC apps in a specific order, because
the Starter Pack and Service Requests process apps contain unique
references to one another. This ensures that the proper forms in the
Starter Pack process app are available for use in each of the services.
Promote the SRC apps in the following order:

a. SRC - Starter Pack Forms – IT

b. SRC - Service Requests

c. SRC - Starter Pack Forms – IT (promote again)

d. SRC – Knowledge Management

Important: If you want to preserve any custom modifications that you
made to these process apps, follow the steps in Preserving Changes in the
Process Apps [page 24] to compare and merge the changes and then
deploy the process apps instead of promoting them.

7. Import the SSM 3.1 solution and promote the four process apps. Select Merge
Conflicts during each promotion.

Important: If you want to preserve any custom modifications that you
made to these process apps, follow the steps in Preserving Changes in the
Process Apps [page 24] to compare and merge the changes and then
deploy the process apps instead of promoting them.

8. Open SBM System Administrator.
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9. Import the Incident data from the backed up database you restored in step 1 by
performing the following steps:

a. From the Tools menu, select Import from Database. Click Next.

b. Select Create New Import Option Set. Click Next.

c. Select Import from another Serena Business Manager database.

d. Specify an ODBC data source for the backed up database (remember to create it
as a System DSN if you need to create the ODBC).

e. In the Source Table drop-down list, select Incidents.

f. Select the Limit by Source Project check box, and then select the Incidents
project. Click Next.

g. In the Destination Table drop-down list, select Incidents.

h. In the Destination Project drop-down list, select Incidents <- Incident
Management <- Base Project. Click Next.

i. Click Map System Fields. Map all other fields that share the same name. Click
Next.

j. Leave the default options selected on the Additional Data Options dialog box.
Click Next.

k. Enter a name for this import option set (like Incidents). Click Finish.

l. From the Tools menu, select Import from Database.

m. Select Execute imports with existing Import Option Set(s) and select the
import set you just created (like Incidents). Click Next.

n. Click Finish to execute the import.

o. Verify that your data is now available in the SBM User Workspace.

10. Import the Service Requests data from the backed up database you restored in step
1 by performing the following steps:

a. From the Tools menu, select Import from Database. Click Next.

b. Select Create New Import Option Set. Click Next.

c. Select Import from another Serena Business Manager database.

d. Specify an ODBC data source for the backed up database (remember to create it
as a System DSN if you need to create the ODBC).

e. In the Source Table drop-down list, select Incidents.

f. Select the Limit by Source Project check box, and then select the Service
Requests project. Click Next.

g. In the Destination Table drop-down list, select Service Requests.
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h. In the Destination Project drop-down list, select General Service Requests
<- Service Request <- Base Project.

i. Click Map System Fields. Map all other fields that share the same name. Click
Next.

Tip: Consider setting a constant user with item ownership privileges for
the Fulfiller and Purchaser fields. These fields drive ownership in the
Fulfillment and Purchasing states.

j. Leave the default options selected on the Additional Data Options dialog box.
Click Next.

k. Enter a name for this import option set (like Service Requests). Click Finish.

l. From the Tools menu, select Import from Database.

m. Select Execute imports with existing Import Option Set(s) and select the
import set you just created. Click Next.

n. Click Finish to execute the data import.

o. Repeat these steps for the Tasks project to migrate task data as well. In the
Tasks import option set that you create, select the Limit by Source Project
check box, select the Tasks project, and then select Service Request Tasks <-
Service Request <- Base Project in the Destination Project drop-down list
on the following dialog box. Click Map System Fields and map all other fields
that share the same name.

p. Perform the same data import steps (without selecting projects) for the following
auxiliary tables that have been moved to the SRC - Service Requests process
app:

• SRC - Client Software

• SRC - Computer Models

• SRC - Computer Types

• SRC - Mobile Carriers

• SRC - Mobile Device Platforms

• SRC - Mobile Devices

• SRC - Operating Systems

For example, create a new import option set for Client Software table that was
part of the 2.1 version. Import the data from this table into the new version:
SRC - Client Software. This ensures that any of the auxiliary data that you added
to the Incident Managment versions of these tables is preserved.

q. Verify that your data is now available in the SBM User Workspace.

11. Launch Serena Request Center, click Customize, and select Service Catalog.
Review each service and catalog in the Request Center to ensure accuracy and
uniqueness.
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12. Edit each service that appears throughout the catalog and select the new
corresponding version of each project, if a new version is available. (When you
customize the Service Catalog, a red exclamation mark will appear next to each
service that needs to be updated). For example, edit the Printer Service Request
service, and change the Process App drop-down list selection from Incident
Management to Service Request. Once the Project drop-down selections are
updated, search for the new Printer Service Request project, and then click Save.

Note: The services and projects must have a one-to-one relationship. This
means each service must have a dedicated project; the same project
cannot be selected in multiple services.

Upgrading 2.x Process Apps to 3.1 Without Upgrading
Incident Management
To upgrade your existing process apps, but continue to use your current version
of the Incident Management :

1. Install and configure SOO 3.1 as described in Chapter 3: Upgrading the Installation
[page 11]. This upgrades the SOO framework files.

2. Launch Application Repository

3. Import the SRC 3.1 solution and promote the three process apps. Select Merge
Conflicts during each promotion.

Important: You must promote the SRC apps in a specific order, because
the Starter Pack and Service Requests process apps contain unique
references to one another. This ensures that the proper forms in the
Starter Pack process app are available for use in each of the services.
Promote the SRC apps in the following order:

a. SRC - Starter Pack Forms – IT

b. SRC - Service Requests

c. SRC - Starter Pack Forms – IT (promote again)

d. SRC – Knowledge Management

Important: If you want to preserve any custom modifications that you
made to these process apps, follow the steps in Preserving Changes in the
Process Apps [page 24] to compare and merge the changes and then
deploy the process apps instead of promoting them.

4. Import the SSM 3.1 solution and promote all of the process apps except for SSM –
Incident Management. Select Merge Conflicts during each promotion.

Important: If you want to preserve any custom modifications that you
made to these process apps, follow the steps in Preserving Changes in the
Process Apps [page 24] to compare and merge the changes and then
deploy the process apps instead of promoting them.

5. Launch Serena Request Center, click Customize, and select Service Catalog.
Review each service and catalog in the Request Center to ensure accuracy and
uniqueness.
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6. Edit each service that appears throughout the catalog and select the new
corresponding version of each project, if a new version is available. (When you
customize the Service Catalog, a red exclamation mark will appear next to each
service that needs to be updated). For example, edit the Printer Service Request
service, and change the Process App drop-down list selection from Incident
Management to Service Request. Once the Project drop-down selections are
updated, search for the new Printer Service Request project, and then click Save.

Note: The services and projects must have a one-to-one relationship. This
means each service must have a dedicated project; the same project
cannot be selected in multiple services.

Preserving Changes in the Process Apps
This section describes steps you will follow to preserve any changes you made to your
current process apps.

If you want to preserve changes that you made to your existing apps, use the Compare
feature in SBM Composer to copy your modifications into the 3.1 apps and preserve them.

To merge your existing apps with the 3.1 versions and preserve modifications:

1. Launch SBM Composer, and then open the 3.1 version of the process app from the
repository (which should appear after you have finished importing the 3.1 solutions).

Tip: Make sure not to open the local cache copy of the process app. If you
are asked to overwrite or use a local copy, choose to overwrite.

2. Click the Composer button and then Compare. Select the option to compare With
Local File.

3. Select the current version of the file that you saved earlier to create the comparison
report. This version should contain all of the changes you have made to date.

4. Use the comparison report that you generated earlier to identify the elements that
you want to preserve on the right side. Right-click the element to preserve, and then
select Copy to Open Process App to copy the change into the 3.1 version of the
app.

5. Save the changes to the 3.1 process app, and then deploy this version. You should
now have a modified 3.1 version of the process app in your repository.

6. Repeat these steps for each process app that has changes you want to preserve.
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Chapter 5: Upgrading SSM 3.0 Process
Apps

This section discusses how to upgrade your SSM 3.0 process apps to SOO 3.1.

• About Upgrading [page 25]

• Upgrading the Process Apps [page 27]

• Preserving Changes in the Process Apps [page 33]

About Upgrading
This section contains important information about upgrading version 3.0 process apps to
Serena Orchestrated Ops 3.1. Use this section to help you evaluate the changes that have
been made to the process apps and whether or not you want to upgrade to take
advantage of the improvements.

Process App Changes Between 3.0 and 3.1
This sections describes the changes that have been to the process apps since version 3.0.
Review the changes below to help you determine if you want to upgrade your process
apps to the latest versions.

Service Request Changes

With Orchestrated Ops 3.1, the request fulfillment workflows have been removed from the
Service Desk application. A new Service Requests application has been created. It
contains one request fulfillment workflow.

The Service Requests application is part of the Serena Request Center solution.

The application, previously known as Service Desk, has been renamed to SSM - Incident
Management, and it only contains the Incident Management workflow.

Starter Pack Changes

The Starter Pack has been changed to the point to the new Service Request process app
included with the Serena Request Center. The starter pack now creates subprojects under
the main project associated with this process app. All services that are created point to
this process app. Note that the starter pack includes:

• Service Desk Process App, which includes the Request Fulfillment workflow.

• Starter Pack Services, which are predefined services in Request Center. Each service
has an accompanying project created within the Service Desk Process App.
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• Starter Pack Forms, which are tailored submit and state forms for the different
services.

Note: Starter Pack Forms makes use of external forms, which were
introduced in Serena Business Manager 10.1. External forms are located in
one process app but are based on a primary table in another process app.
Starter Pack Forms reference the Service Desk Process App and the
external forms are chosen as the Submit form for the predefined Starter
Pack Services.

About Importing and Promoting
This section provides an overview of the import and promote steps you will follow to
upgrade your current process apps.

Importing the Solutions

To begin upgrading your process apps, you must import the new solution files that are
delivered by the installer. Importing a solution adds all of the snapshots and process apps
for the solution to your SBM Server. The process apps and snapshots are available for
promotion after the import.

To import the solutions:

1. Log in to SBM Application Repository using the following URL:

http://serverName:port/mashupmgr

2. Select the Solutions tab.

3. Click the Import button to begin importing a solution.

Note: A failure message that states "You do not have permission to delete
the obselete snapshot" appears in Application Repository if your
environment contains a process app that is no longer associated with the
solution you are importing and you do not have privileges to delete the
process app. In the Deployment menu, click Privileges, and then grant
the user Delete Process App and Delete Application/Orchestration
privileges to proceed with the import.

4. If you import the Serena Request Center solution for the first time as part of the
upgrade, read the steps described in the "Promoting the Snapshots" chapter in the
Serena Orchestrated Ops On-Premise Installation and Configuration Guide before
you promote the Serena Request Center process app snapshots.

Promoting the Process Apps

After you import a solution, you promote the associated snapshots into your environment.
Promoting the snapshots places the contents of the solution, including all reports,
notifications, process apps, and auxiliary table data, onto your SBM Server.

If you are upgrading from an earlier version, it is likely that you modified the process
apps; therefore, the solutions that are delivered by the installer are not automatically
deployed to your default environment. Before you promote the process apps, you must
decide if you want to overwrite the current versions of your process apps or if you want to
preserve your modifications. Choose one of the following two options:
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• Review the comparison report you generated as part of the pre-upgrade process. If
there are modifications that you made to the process apps that you want to
preserve, use SBM Composer to compare and merge your changes and then deploy
the process apps.

• Promote the new versions without comparing and merging, which will overwrite your
modifications (if any).

Important: Promoting the new snapshots overlays any existing
modifications that you have made to your existing workflows.

Note: During the promotion, select the Merge conflicts option if you have
already promoted an earlier version of the snapshot to the target environment
and you want to preserve changes that you made to the existing application. For
example, if you want to keep new user roles that you added to an application,
select the Merge conflicts check box to preserve them in the target
environment after the promotion. If Merge conflicts is not selected, the
existing entities will be deleted in the target environment.

The following section describes the process app uppgrade process in more detail.

Upgrading the Process Apps
This section describes three different scenarios for upgrading the SSM 3.0 process apps.

As of SOO 3.1, the Service Request workflow has been removed from the Service Desk
process app that was included with SSM and SRC in version 3.0. In its place, a new
Service Requests process app has been created as part of the SRC solution. The Service
Desk process app that was formerly part of the SRC solution has been renamed to
"Incident Management" in 3.1 (though it has the same UUID). Given these changes, there
are special upgrade considerations for the Service Desk process app.

Depending on how you have used the Service Request and Incident workflows in 3.0,
there are three upgrade options for the Service Desk process app:

• Upgrade and delete all existing Service Desk data. For details, see Upgrading 3.0
Process Apps to 3.1 and Deleting Existing Service Desk Data [page 27].

• Upgrade and preserve your existing Service Desk data. For details, see Upgrading
3.0 Process Apps to 3.1 and Preserving Existing Service Desk Data [page 29].

• Leave the current version of the Service Desk intact and continue using your existing
Service Request, Incident, and Task workflows. For details, see Upgrading 3.0
Process Apps to 3.1 Without Upgrading Service Desk [page 32].

Upgrading 3.0 Process Apps to 3.1 and Deleting
Existing Service Desk Data
To upgrade your existing 3.0 process apps and delete your current Service Desk
data:

1. Install and configure SOO 3.1 as described in Chapter 3: Upgrading the Installation
[page 11]. This upgrades the SOO framework files.

2. Launch Application Repository.
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3. Grant your user account the following privileges: Delete Process App and Delete
Application/Orchestration.

4. Open the Environments view, click Deployed Process Apps, select the 3.0
version of the SSM – Service Desk process app, and click Undeploy Process App.

Important: This operation permanently deletes the SSM - Service Desk
3.0 primary tables, auxiliary tables, workflows, and projects.

5. Import the SRC 3.1 solution and promote the three process apps. Select Merge
Conflicts during each promotion.

Important: You must promote the SRC apps in a specific order, because
the Starter Pack and Service Requests process apps contain unique
references to one another. This ensures that the proper forms in the
Starter Pack process app are available for use in each of the services.
Promote the SRC apps in the following order:

a. SRC - Starter Pack Forms – IT

b. SRC - Service Requests

c. SRC - Starter Pack Forms – IT (promote again)

d. SRC – Knowledge Management

Important: If you want to preserve any custom modifications that you
made to these process apps, follow the steps in Preserving Changes in the
Process Apps [page 33] to compare and merge the changes and then
deploy the process apps instead of promoting them.

6. Import the SSM 3.1 solution and promote the four process apps. Select Merge
Conflicts during each promotion.

Important: If you want to preserve any custom modifications that you
made to these process apps, follow the steps in Preserving Changes in the
Process Apps [page 33] to compare and merge the changes and then
deploy the process apps instead of promoting them.

7. Launch Serena Request Center, click Customize, and select Service Catalog.
Review each service and catalog in the Request Center to ensure accuracy and
uniqueness.

8. Edit each service that appears throughout the catalog and select the new
corresponding version of each project, if a new version is available. (When you
customize the Service Catalog, a red exclamation mark will appear next to each
service that needs to be updated). For example, edit the Printer Service Request
service, and change the Process App drop-down list selection from Incident
Management to Service Request. Once the Project drop-down selections are
updated, search for the new Printer Service Request project, and then click Save.

Note: The services and projects must have a one-to-one relationship. This
means each service must have a dedicated project; the same project
cannot be selected in multiple services.
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Upgrading 3.0 Process Apps to 3.1 and Preserving
Existing Service Desk Data
To upgrade your existing 3.0 process apps and preserve your current Service
Desk data:

1. Create a backup of your SBM database. Consult your DBA and restore this backup
into a new database space or schema.

2. Install and configure SOO 3.1 as described in Chapter 3: Upgrading the Installation
[page 11]. This upgrades the SOO framework files.

3. Launch Application Repository.

4. Grant your user account the following privileges: Delete Process App and Delete
Application/Orchestration.

5. Open the Environments view, click Deployed Process Apps, select the 3.0
version of the SSM – Service Desk process app, and click Undeploy Process App.

Important: This operation permanently deletes the Service Desk primary
tables, auxiliary tables, workflows, and projects. The following steps will
help you restore these elements and their associated data.

6. Import the SRC 3.1 solution and promote the three process apps. Select Merge
Conflicts during each promotion.

Important: You must promote the SRC apps in a specific order, because
the Starter Pack and Service Requests process apps contain unique
references to one another. This ensures that the proper forms in the
Starter Pack process app are available for use in each of the services.
Promote the SRC apps in the following order:

a. SRC - Starter Pack Forms – IT

b. SRC - Service Requests

c. SRC - Starter Pack Forms – IT (promote again)

d. SRC – Knowledge Management

Important: If you want to preserve any custom modifications that you
made to these process apps, follow the steps in Preserving Changes in the
Process Apps [page 33] to compare and merge the changes and then
deploy the process apps instead of promoting them.

7. Import the SSM 3.1 solution and promote the four process apps. Select Merge
Conflicts during each promotion.

Important: If you want to preserve any custom modifications that you
made to these process apps, follow the steps in Preserving Changes in the
Process Apps [page 33] to compare and merge the changes and then
deploy the process apps instead of promoting them.

8. Open SBM System Administrator.

Upgrade Guide 29



9. Import the Incident data from the backed up database you restored in step 1 by
performing the following steps:

a. From the Tools menu, select Import from Database. Click Next.

b. Select Create New Import Option Set. Click Next.

c. Select Import from another Serena Business Manager database.

d. Specify an ODBC data source for the backed up database (remember to create it
as a System DSN if you need to create the ODBC).

e. In the Source Table drop-down list, select Incidents.

f. Select the Limit by Source Project check box, and then select the Incidents
project under Service Desk. Click Next.

g. In the Destination Table drop-down list, select Incidents.

h. In the Destination Project drop-down list, select Incidents <- Incident
Management <- Base Project. Click Next.

i. Click Map System Fields. Map all other fields that share the same name. Click
Next.

j. Leave the default options selected on the Additional Data Options dialog box.
Click Next.

k. Enter a name for this import option set (like Incidents). Click Finish.

l. From the Tools menu, select Import from Database.

m. Select Execute imports with existing Import Option Set(s) and select the
import set you just created (like Incidents). Click Next.

n. Click Finish to execute the import.

o. Verify that your 3.0 data is now available in the SBM User Workspace.

10. Import the Service Requests data from the backed up database you restored in step
1 by performing the following steps:

a. From the Tools menu, select Import from Database. Click Next.

b. Select Create New Import Option Set. Click Next.

c. Select Import from another Serena Business Manager database.

d. Specify an ODBC data source for the backed up database (remember to create it
as a System DSN if you need to create the ODBC).

e. In the Source Table drop-down list, select Incidents.

f. Select the Limit by Source Project check box, and then select a Service
Request sub-project. For example, select Printer Service Request if users
submitted items into that project in SSM 3.0. Click Next.

g. In the Destination Table drop-down list, select Service Requests.
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h. In the Destination Project drop-down list, select the new version of the Service
Request project that corresponds to the older version. To continue with the
previous example, select Printer Service Request <-IT Services for Users <-
Service Request.

i. Click Map System Fields. Map all other fields that share the same name. Click
Next.

j. Leave the default options selected on the Additional Data Options dialog box.
Click Next.

k. Enter a name for this import option set (like Printer Service Requests). Click
Finish.

l. From the Tools menu, select Import from Database.

m. Select Execute imports with existing Import Option Set(s) and select the
import set you just created. Click Next.

n. Click Finish to execute the data import.

o. Repeat these steps for each Service Request project.

p. Repeat these steps for the Tasks project to migrate task data as well. In the
Tasks import option set that you create, select the Limit by Source Project
check box, select the Tasks project, and then select Service Request Tasks <-
Service Request <- Base Project in the Destination Project drop-down list
on the following dialog box.

q. Perform the same data import steps (without selecting projects) for the following
auxiliary tables that have been moved to the SRC - Service Requests process
app:

• SRC - Client Software

• SRC - Computer Models

• SRC - Computer Types

• SRC - Mobile Carriers

• SRC - Mobile Device Platforms

• SRC - Mobile Devices

• SRC - Operating Systems

For example, create a new import option set for Client Software table that was
part of the 3.0 version of Service Desk. Import the data from this table into the
new version: SRC - Client Software. This ensures that any of the auxiliary data
that you added to the Service Desk versions of these tables is preserved.

r. Verify that your 3.0 data is now available in the SBM User Workspace.

11. Launch Serena Request Center, click Customize, and select Service Catalog.
Review each service and catalog in the Request Center to ensure accuracy and
uniqueness.
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12. Edit each service that appears throughout the catalog and select the new
corresponding version of each project, if a new version is available. (When you
customize the Service Catalog, a red exclamation mark will appear next to each
service that needs to be updated). For example, edit the Printer Service Request
service, and change the Process App drop-down list selection from Incident
Management to Service Request. Once the Project drop-down selections are
updated, search for the new Printer Service Request project, and then click Save.

Note: The services and projects must have a one-to-one relationship. This
means each service must have a dedicated project; the same project
cannot be selected in multiple services.

Upgrading 3.0 Process Apps to 3.1 Without Upgrading
Service Desk
To upgrade your existing 3.0 process apps, but continue to use your current
version of the Service Desk:

1. Install and configure SOO 3.1 as described in Chapter 3: Upgrading the Installation
[page 11]. This upgrades the SOO framework files.

2. Launch Application Repository

3. Import the SRC 3.1 solution and promote the three process apps. Select Merge
Conflicts during each promotion.

Important: You must promote the SRC apps in a specific order, because
the Starter Pack and Service Requests process apps contain unique
references to one another. This ensures that the proper forms in the
Starter Pack process app are available for use in each of the services.
Promote the SRC apps in the following order:

a. SRC - Starter Pack Forms – IT

b. SRC - Service Requests

c. SRC - Starter Pack Forms – IT (promote again)

d. SRC – Knowledge Management

Important: If you want to preserve any custom modifications that you
made to these process apps, follow the steps in Preserving Changes in the
Process Apps [page 33] to compare and merge the changes and then
deploy the process apps instead of promoting them.

4. Import the SSM 3.1 solution and promote all of the process apps except for SSM –
Incident Management. Select Merge Conflicts during each promotion.

Important: If you want to preserve any custom modifications that you
made to these process apps, follow the steps in Preserving Changes in the
Process Apps [page 33] to compare and merge the changes and then
deploy the process apps instead of promoting them.

5. Launch Serena Request Center, click Customize, and select Service Catalog.
Review each service and catalog in the Request Center to ensure accuracy and
uniqueness.
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6. Edit each service that appears throughout the catalog and select the new
corresponding version of each project, if a new version is available. (When you
customize the Service Catalog, a red exclamation mark will appear next to each
service that needs to be updated). For example, edit the Printer Service Request
service, and change the Process App drop-down list selection from Incident
Management to Service Request. Once the Project drop-down selections are
updated, search for the new Printer Service Request project, and then click Save.

Note: The services and projects must have a one-to-one relationship. This
means each service must have a dedicated project; the same project
cannot be selected in multiple services.

Preserving Changes in the Process Apps
This section describes steps you will follow to preserve any changes you made to your
current process apps.

If you want to preserve changes that you made to your existing apps, use the Compare
feature in SBM Composer to copy your modifications into the 3.1 apps and preserve them.

To merge your existing apps with the 3.1 versions and preserve modifications:

1. Launch SBM Composer, and then open the 3.1 version of the process app from the
repository (which should appear after you have finished importing the 3.1 solutions).

Tip: Make sure not to open the local cache copy of the process app. If you
are asked to overwrite or use a local copy, choose to overwrite.

2. Click the Composer button and then Compare. Select the option to compare With
Local File.

3. Select the current version of the file that you saved earlier to create the comparison
report. This version should contain all of the changes you have made to date.

4. Use the comparison report that you generated earlier to identify the elements that
you want to preserve on the right side. Right-click the element to preserve, and then
select Copy to Open Process App to copy the change into the 3.1 version of the
app.

5. Save the changes to the 3.1 process app, and then deploy this version. You should
now have a modified 3.1 version of the process app in your repository.

6. Repeat these steps for each process app that has changes you want to preserve.

Upgrade Guide 33



Chapter 5: Upgrading SSM 3.0 Process Apps

34 Serena® Orchestrated Ops



Chapter 6: Post-upgrade Tasks

This section describes tasks you perform after you upgrade your installation SOO 3.1.

Updating Services in Serena Request Center
• Each service definition in Serena Request Center requires its own project. This

means you must review all the services in the entire service catalog and set the
correct project or create new projects for them.

Note: The services and projects must have a one-to-one relationship. This
means each service must have a dedicated project; the same project
cannot be selected in multiple services.

• Log in to the Request Center and set the display order for categories and services.

• Deploying the Starter Pack Forms adds the new Starter Pack Services. You may want
to disable these services by hiding them in Serena Request Center. Refer to the
Serena Orchestrated Ops On-Premise Installation and Configuration Guide for a list
of these services.

Preparing the System for Use
• After you have promoted the SRC - Service Requests snapshot, configure the

Requests view in Request Center to point at the "Requests Center - My Requests"
report contained in the snapshot. See Serena Orchestrated Ops Administrator's
Guide for details on configuring Request Center.

• If you also have SSM, modify the multi-table report, "Requests Center - My
Requests," under the Service Requests solution tab to include the Incident
Management table. This allows users to see incidents that they have submitted in
Request Center.

• If you also have SDM, modify the multi-table report, "Requests Center - My
Requests," under the Service Requests solution tab to include the Project Proposal
table. This allows users to see project proposals that they have submitted in Request
Center.

• Determine if you need to configure your orchestrations to be authenticated under a
specific user account as described in the "Setting Authentication for Orchestrations"
topic in the Serena Orchestrated Ops On-Premise Installation and Configuration
Guide.

• Add auxiliary data, set default field values, assign users to appropriate roles, and
define SLAs as described in the Serena Orchestrated Ops Administrator's Guide.
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